
Creating Graphics

Introduction

Flash offers a full suite of tools for creating and editing
graphics. When you draw in Flash, you create vector art.
VVeeccttoorrss are mathematical descriptions of lines and points
that, when connected, form shapes and objects. Vector-
defined art is not limited by resolution like bitmaps are so
they can be scaled to any size without a loss in quality or
increase in file size. This is the basis of Flash; the main reason
Flash files are so small and why they can be deployed on so
many platforms. Vector graphics are also fully editable after
they are created so you can continue to adjust their proper-
ties. Included in Flash are many of the drawing tools and pro-
cedures familiar to the seasoned user of vector drawing
programs. It is also a good place for the beginner to learn.
Sketch naturally with the Pencil and Brush tools or use vec-
tor-based objects, such as the Rectangle or Oval tools or the
Polystar tool. Use the Pen tool to create lines and shapes
with Bézier curves. Whatever is drawn can be edited and
modified with a variety of tools and palettes. When you select
an object or graphic on the Stage, the Property Inspector dis-
plays the attributes of that object that are modifiable, such as
fill and stroke color, position, and scale. 

You can draw shapes in Flash using two drawing models:
Merge Drawing and Object Drawing. The MMeerrggee  DDrraawwiinngg
model, the default (like previous versions of Flash), automati-
cally merges shapes that you draw when you overlap them.
If you select a shape that has been merged with another, and
move it, the shape below it is moved too. The OObbjjeecctt  DDrraawwiinngg
model allows you to draw shapes as separate objects that do
not automatically merge together when you overlap them.
You can now extend the Object Drawing mode by creating
primitive rectangles and ovals in PPrriimmiittiivvee  mmooddee (New!),
which allows you to edit properties in the Property Inspector
and specify the corner radius of rectangles and inner radius
of ovals. This makes it easy to create pie wedges, round off
corners, and other curved shapes.

3

3
What You’ll Do

Change Drawing Settings

Draw Lines and Shapes

Use the Selection Tools

Zoom In and Out

Move Around with the Hand Tool

Use Rulers, Grids, and Guides

Modify Grid and Guide Settings

Use Snap Align

Change Stroke and Fill Colors

Create Custom Colors

Edit Strokes with the Ink Bottle

Edit Fills with the Paint Bucket

Edit Strokes and Fills with the 
Eyedropper

Create Gradients

Use the Fill Lock

Use Paint Brush Modes

Draw with the Pen Tool

Modify Shapes

Use the Free Transform Tool

Use Transform Options for Shapes
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The Drawing category on the Preferences dialog box contains a num-
ber of drawing settings that control the sensitivity and behavior of
Flash's drawing tools. Make changes to the tolerance levels for
smoothing or straightening, set the sensitivity for line and shape recog-
nition, or fine-tune snapping. You can exercise greater control over
your drawing or allow Flash to perform corrections and adjustments as
you draw. You can customize the way you use Pen tools, draw connect-
ing lines and smooth curves, and recognize line and shapes. 

Changing Drawing
Settings

Change the Drawing Settings

Click the Flash (Mac) or Edit (Win)
menu, and then click Preferences. 

Click the Drawing category.

Specify the drawing option you
want:

◆ Pen Tool options. Select check
boxes to show pen preview,
solid points, and precise
cursors.

◆ Connect Lines. Determines how
close the ends of any two lines
need to be before Flash
connects them. It controls when
a line is converted into a
perfectly straight line. 

◆ Smooth Curves. Determines the
amount of smoothing applied to
a drawn line. The lower the
smoothing applied, the closer
the line appears to what you
have drawn. 

◆ Recognize Lines. Defines how a
straight line drawn with the
Pencil tool must be before it’s
converted into a perfectly
straight line.

◆ Recognize Shapes. Sets how
precise simple geometric
shapes must be drawn before
they are detected as shapes.

◆ Click Accuracy. Determines
how near to a shape the pointer
must be before Flash recognizes
it. 

Click OK.4

3

2

1
2

3

4
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Drawing with the 
Line Tool

Use the Line Tool

Click the Line tool in the Toolbar. 

The pointer becomes a crosshair
that you can drag on the Stage.

TIMESAVER Press N to select
the Line tool.

Click and drag on the Stage, and
then release the mouse when the
line is the length you need. 

TIMESAVER Hold down the
Shift key, and then drag to draw a
45 degree line. 

To change line properties, click to
select the stroke, and then specify
the options (Color, Weight (0-200),
Style, Width and Height, Cap, Join,
or Stroke Hinting) you want in the
Property Inspector.

TROUBLE? To display the
Property Inspector, click the
Window menu, point to Properties,
and then click Properties. 

3

2

1

The Line tool draws perfectly straight lines in any direction you drag
your mouse. In Flash, a line is called a stroke and there is a variety of
thickness (0-200 pixels), styles, colors, and gradient fills that can be
applied to it. You can also create your own line style for specific types
of dashed, dotted or artistic lines. You can constrain the path a line
draws to 45-degree angles or create closed shapes by intersecting the
lines you draw. In Merge Drawing, when a line overlaps another line on
the same layer, it essentially 'cuts' it into two pieces that can be edited
as separate objects. You can also specify a line cap and join type. A
join is the place where two strokes meet (Miter, Round, or Bevel). A
cap is the end point of a stroke that does not join with another stroke.
Select Stroke hinting to make stroke intersections easier to view. 

See Also
See “Changing Stroke and Fill Colors”
on page 96  for information on using
color.

2

1

3
Stroke

Color
Stroke
Weight

Stroke
Style

Customize
styles

Stroke width
and height

Fill
Color

Cap and Join
options

A preview of the line appears as you
drag. A circle beneath the crosshair
indicates the line's endpoint. 

Stroke
Hinting

Stroke join
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Drawing with the
Pencil Tool

Use the Pencil Tool in 
Straighten Mode

Click the Pencil tool in the Toolbar.  

The pointer becomes a pencil. The
Pencil tool options appear at the
bottom of the Toolbar. The default
mode is Straighten.

TIMESAVER Press Y to select
the Pencil tool.

Draw on the Stage with the Pencil,
and then release the mouse. 

A rough preview of the line
appears as you draw. In Straighten
mode, Flash transforms the line
into a series of straight-line
segments and standard curves.

2

1

Use the Pencil tool for freeform drawing. When you draw with the
Pencil tool you are creating strokes. It works the same way as a real
pencil with options for smoothing and straightening. Depending upon
which mode you choose, Flash makes corrections to the drawn line.
Smooth mode softens the curve of the line you draw while Straighten
mode transforms the line into a series of straight-line segments and
standard curves. If you are using the Pencil or Brush tools with Smooth
mode, you can specify the degree of smoothness. Additionally, Flash
performs shape recognition to the lines you draw so that if it detects
something approximating a simple geometric shape such as a rectan-
gle, oval, or triangle, it converts your drawing into whichever shape it
detects. To bypass these modifications, select Ink mode. This mode
allows for the most freeform drawing with minimal correction by Flash.

Did You Know?
Flash converts rough shapes into
clean, geometric shapes. If you draw a
rough rectangle in Straighten mode,
Flash converts your shape into a clean
rectangle with straight sides. It does
the same for other shapes, such as
ovals and triangles. Set the tolerance
level of shape recognition in the
Drawing preferences.

1

Pencil mode is set to
straighten by default.

Flash straightens
the drawn line.

Flash applies shape recognition
in Straighten mode. 

2
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Use the Pencil Tool in 
Smooth Mode

Click the Pencil tool in the Toolbar.   

The pointer becomes a pencil. The
Pencil tool options appear at the
bottom of the Toolbar. 

Click the Pencil mode popup in the
Options area of the Toolbar, and
then click Smooth.

In the Property Inspector, click the
Smoothing popup, and then click a
value from 1 to 100 (New!). 

The default value is set to 50. The
greater the smoothing value, the
smoother the resulting line. 

TROUBLE? To display the
Property Inspector, click the
Window menu, point to Properties,
and then click Properties. 

Draw on the Stage with the Pencil,
and then release the mouse.  

A rough preview of the line
appears as you draw. In Smooth
mode, Flash smoothes the line you
draw into curved line segments.

4

3

2

1

Did You Know?
You can disable straightening and
smoothing. Click the Pencil mode
popup in the Options area of the
Toolbar, and then click Ink mode to
yield a line closest to the line you've
drawn with minimal corrections 
performed by Flash.

4 Flash smoothes
the drawn line.

2

Use Ink mode for more freeform drawing.

3

1

For Your Information

Smoothing Curves Another Way
You can also smooth curves by optimizing the shape. Optimizing a
shape refines curved lines and fill outlines by reducing the number of
curves used to define the shape. To optimize a shape, click it, click
the Modify menu, point to Shape, click Optimize, specify a smoothing
level, select additional options (select Use Multiple Passes to repeat
the smoothing process until you can’t anymore, and select Show
Totals Message to display an alert when smoothing is complete), and
then click OK.
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Drawing Shapes with
the Rectangle and
Oval Tools

Draw with the Oval Tool 

Click the Oval or Oval Primitive
tool in the Toolbar. 

TIMESAVER Press O to select
an Oval tool.

Select a Stroke and Fill Color from
the Colors area of the Toolbar.

Click and drag on the Stage, and
then release the mouse. 

TIMESAVER Press and hold
Shift while you drag to create a
circle.

In the Properties Inspector,
change the values you want. 

Draw with the Rectangle Tool 

Click the Rectangle or Rectangle
Primitive tool in the Toolbar. 

TIMESAVER Press R to select
a Rectangle tool.

Select a Stroke and Fill color from
the Colors area of the Toolbar. 

Click and drag on the Stage, and
then release the mouse. 

TIMESAVER Press and hold
Shift while you drag to create a
square.

In the Properties Inspector,
change the values you want. 

4

3

2

1

4

3

2

1

The Flash Toolbar includes several tools for quickly creating simple
geometric vector shapes. They are easy to use; you just click and drag
on the Stage to create the shapes. The Rectangle tool creates rectan-
gles with square or rounded sides. The Oval tool creates circular
shapes such as ovals and circles. These shapes can be comprised of
Strokes, which are lines that surround and define the shape, Fills,
which are a color or texture inside the shape, or both. You can create
two types of shapes: Drawing or Primitive. Drawing, or standard,
shapes are self contained; the stroke and fill of a shape are not sepa-
rate elements, while Primitive shapes (New!) are separate elements. 

1 32

1 32
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Draw a Rounded Rectangle

Click the Rectangle or Rectangle
Primitive tool in the Toolbar. 

Enter a value for the corner radius
in the Properties Inspector
(New!). 

To create an exact size rectangle
shape, select the shape, enter the
width and height values in the
Properties Inspector (New!). 

Click and drag on the Stage, and
then release the mouse. 

4

3

2

1

Did You Know?
You can enter values ranging from 0 to
100 points in the Rectangle Settings
dialog box. A value of zero gives you a
straight-sided-square. Higher numbers
produce squares with more rounded
sides.

You can hold down the Shift key while
dragging to produce a perfect square
with equal sides or a perfect circle. If
you want to draw an oval or a rectan-
gle without a stroke or fill, you can set
either of these options to No Fill in the
Colors area of the Toolbar or in the
Color Mixer.

You can draw shapes without a stroke
or a fill. Set either of these properties
to No Fill in the Colors section of the
Toolbar or in the Color Mixer.

You can set specific sizes with a dia-
log box. Alt+click (Win) or Option+click
(Mac) a rectangle or oval, set the val-
ues you want, and then click OK.

See Also
See “Changing Stroke and Fill Colors”
on page 96 for information on changing
shapes.

5 points 25 points 50 points

1

For Your Information

Creating Primitive Rectangles and Ovals
In addition to creating standard rectangles and ovals, you can now
create Primitive rectangles and ovals (New!). A Primitive shape
allows you to change their attributes in the Property Inspector. The
Primitive shape tools allow you to specify the corner radius of rec-
tangles, and the start and end angle and the inner radius of ovals
using controls in the Property Inspector, which makes it easy to cre-
ate pie wedges, round off corners, and other curved shapes. When
either of the Primitive shape tools is selected, the Property Inspector
retains the values of the last primitive object that you edited.

3 2
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Using the Polystar 
Tool

Draw a Polygon or Star Shape

Click and hold the Rectangle tool
in the Toolbar, and then point to
PolyStar Tool. 

The pointer becomes a crosshair
that you can drag anywhere on the
Stage.

Click Options in the Property
Inspector. 

TIMESAVER Press A+F3
(Mac) or Ctrl+3 (Win) to open the
Property Inspector.

Click the Style popup, and then
select Polygon or Star.

Enter a value for the number of
sides. You can create an object
with up to 32 sides.

For the Star style, you can specify
an additional option for your point
size. You can enter a value ranging
from .10 to 1.0 points.

Click OK.6

5

4

3

2

1

Working in much the same way as the Oval and Rectangle tools, the
new Polystar tool allows you to easily create complex vector shapes.
You can use this tool to create polygons and stars with up to 32 sides.
Choose between creating a polygon or a star. Both styles have charac-
teristics that can be adjusted in the Property Inspector before you draw
the shape. Both the polygon and star style can have up to 32 sides, with
the star style having an additional star point size that can be set.
Experiment with several options to get the kind of shape you want.

See Also
See “Editing Strokes with the Ink
Bottle” on page 100  for information on
editing an object. 

5

4

3

1

2

6
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When you create vector graphics in Flash,
they are comprised of distinct elements that
can be selected separately or as a whole with
a variety of selection tools. The type of editing
you need to perform determines which tool
you use. For example, a simple rectangle
drawn is comprised of four line segments that
surround the contour of the shape and one fill
in the center. Each of these five parts can be
selected in tandem or individually with the
Arrow Selection tool. Likewise, any stroke that
intersects another stroke or fill splits them
into distinct elements that can be selected
separately. 

In Normal selection mode, holding down
the Shift key adds to the selection any addi-
tional elements you click on. You can change
this option in the General tab of the
Preferences window so that it isn't necessary
to use the Shift key to perform this function.

Double-click any stroke to select other strokes
connected to it or double-click a fill to select it
and any strokes that touch or intersect it. To
select an entire shape (strokes and fills) or
just a portion of it, you can drag a selection
rectangle with the Arrow tool or draw a
freeform selection area with the Lasso tool.
These methods work best for very complex
shapes with many intersecting strokes and
fills, or if there is only a portion of the shape
you need to edit.

The Sub-Selection and Pen tools allow you
to select the entire shape (strokes and fills)
simultaneously, making its anchor points and
Bézier handles visible for editing. Use this
method when you need to edit the contours
of the shape with precision.

For information on making selections
using the Object Drawing model, see
“Working with Object Drawing, on page 122.

Understanding Selections

Selection Examples

Each element (4
lines and a fill) can
be selected
separately.

Shift-select to
add elements to

the selection.

Single line segment. When two line segments
intersect, four new line

segments are created that
can be selected

separately.

Double-click a fill
to select it and any
connected strokes.

Double-click a
stroke to select all

connected
strokes.

Click and drag to
select a portion of
the shape.

Only a portion of
the fill and strokes
is selected.

C03FLCS3.qxd  4/1/2007  5:37 AM  Page 81



82

Selecting Strokes 
with the Arrow Tool

Select a Stroke with the Arrow
Selection Tool 

Click the Arrow tool in the Toolbar. 

The pointer becomes an arrow.

TIMESAVER Press V to select
the Arrow tool.

Position the arrow on the edge of
the shape. 

Notice that Flash displays a small
curved line icon when you position
the arrow over a Curve point and a
corner line icon when over a
Corner point.

Click on any part of the stroke. 

Flash only selects a portion of it.
This is because what appears to
be one whole shape is actually a
series of lines connected by points
and each can be selected
separately.  

3

2

1

There are a variety of ways to select objects in Flash. You can select an
object's stroke or fill or both. You can use the Arrow tool to select parts
of the object or drag over a portion of it to create a selection rectangle.
The Property Inspector displays the properties of what is selected
including Stroke line weight and style, Fill color, pixel dimensions, and X
and Y coordinates. When a stroke or fill is selected, a dotted pattern
appears over it indicating it has been selected. This makes editing and
modifying graphics simple and illustrates the versatility of the vector-
based graphics model used in Flash.

1 2 Curve point detected

Corner
point
detected 

3

See Also
See “Working with Object Drawing” on
page 122 for information on selecting
overlapping objects on the same layer.
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Select Multiple Stroke
Segments 

Click the Arrow tool in the Toolbar.

The pointer becomes an arrow. 

TIMESAVER Press V to select
the Arrow tool. You can
temporarily switch to the Arrow
tool from any other tool by
pressing A (Mac) or Ctrl (Win).

Click on any part of the stroke to
select one segment.

Hold down the Shift key, and then
click other strokes to add them to
the selection.

Select Connected Stroke
Segments

Click the Arrow tool in the Toolbar. 

The pointer becomes an arrow.

Double-click any part of the
segment or stroke to select all
connected strokes.

2

1

3

2

1

Did You Know?
You can turn off the Shift-select fea-
ture in the General tab of the
Preferences dialog box. When this
feature is disabled, you can add to the
selected segments by clicking them
without the need to hold down the
Shift key. In this mode, holding the
Shift key and clicking a selected stroke
segment deselects that segment.

1 2

3

Shift-select to add stroke segments 
to the selection.

1 2

All connected
stroke segments
selected.
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Selecting Strokes 
and Fills with the
Arrow Tool

Select Fills with the Arrow
Selection Tool 

Click the Arrow tool in the Toolbar. 

The pointer becomes an arrow.

Position the arrow in the Fill area
or the center of the shape and
click.

The fill becomes highlighted with a
dotted pattern to indicate it has
been selected. Hold down the Shift
key to add other strokes and fills to
the selection.

Select with a Selection
Rectangle  

Click the Arrow tool in the Toolbar. 

The pointer becomes an arrow.

Click on the Stage above and to
the left of the shape you want to
select and drag to create a
Selection Rectangle, and then
release the mouse when the
bounding box fully encloses the
shape.

2

1

2

1

The Arrow tool provides the most simple and versatile procedures for
selecting objects in Flash. The Arrow tool selects anything you click on
(provided it isn't on a locked layer). Double-clicking shapes with the
Arrow tool selects all fills and strokes that are connected. Shift-select-
ing allows you to add to the selection only what you need. Alternately,
dragging a selection rectangle on the Stage with the Arrow tool cre-
ates a bounding box that selects anything you drag it over. This bound-
ing box method is the most reliable technique for selecting very
complex objects with many intersecting strokes and fills.

1

1

2 Selected fill

2

Double-clicking
the shape selects
both the fill and
the stroke.

Both fill and
strokes are
selected.
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Making Selections
with the Lasso Tool

Select with the Lasso Tool

Click the Lasso tool in the Toolbar. 

TIMESAVER Press L to select
the Lasso tool.

Draw around the shapes you want
to select. 

Flash draws a preview of the
selection lasso as you draw.

To complete the selection, return
to the point where you started.  

Select with the Lasso Tool in
Polygon Mode 

Click the Lasso tool in the Toolbar. 

Click the Polygon Mode button in
the Options area of the Toolbar.

Click near the area you want to
select. Move the pointer and click
again. Keep clicking until the
object or portion you want to
select is surrounded.

Double-click to complete the
selection.

4

3

2

1

3

2

1

Use the Lasso tool when you want to select shapes that are too close
to shapes you don't want to select. This tool allows you to draw around
the shape, selecting everything contained in the shape you draw. In the
default mode, you can draw a freeform lasso around the object you
want to select. You can also choose the Polygon mode for defining the
selected area with a series of straight-line segments.

2

Did You Know?
You can combine several ways to
select single or multiple objects.
Holding the Shift key adds line seg-
ments and fills to the selection. Shift-
selecting items that have already been
selected deselects them. 

Selected
shape

3

Selected shape

1 2

1
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Zooming In and Out
with the Magnifying
Glass

Zoom In 

Click the Zoom tool in the Toolbar.   

Click the Enlarge button in the
Options area of the Toolbar. 

The pointer becomes a magnifying
glass with a plus (+) symbol in it.

Click on the area of the Stage you
want to zoom into.

TIMESAVER Press Z to select
the Zoom tool. To temporarily
toggle between the Enlarge and
Reduce Modifiers buttons in the
Options area of the Toolbar, press
Option (Mac) or Alt (Win).

Zoom Out 

Click the Zoom tool in the Toolbar.  

Click the Reduce button in the
Options area of the Toolbar. 

The pointer becomes a magnifying
glass with a minus (-) symbol in it.

Click on the area of the Stage you
want to zoom out from.

3

2

1

3

2

1

Because the Stage and Work Area in Flash share the same space with
a variety of panels, palettes and windows, it is often necessary to
change the magnification level. You can use the Magnifying Glass to
zoom out and see the entire piece or zoom in to do more detailed work
on a small portion. The tool is made up of two modifiers: a plus (+) sym-
bol in the circle indicates enlargement of the Stage and a minus (-) indi-
cates reduction. Flash allows magnification levels from 8 percent to
2000 percent. 

31

1 32

2
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Zoom Into a Specific Area by
Dragging on the Stage

Click the Zoom tool in the Toolbar. 

Click the Reduce or Enlarge button
in the Options area of the Toolbar. 

Click on the area of the Stage you
want to magnify and drag the
pointer. 

3

2

1

Did You Know?
You can change the magnification
level in several places. The Zoom
Control field in the top right hand cor-
ner of the Stage allows you to enter a
value or access a popup with various
magnification levels. You can also
change the magnification submenu in
the View menu or use the keyboard
shortcuts A+ - (Mac) or Ctrl+ - (Win)
to zoom out, and A+ + (Mac) or 
Ctrl+ + (Win) to zoom in. Quickly switch
to 100 percent magnification by press-
ing A+1 (Mac) or Ctrl+1 (Win).

1

2 3

C03FLCS3.qxd  4/1/2007  5:39 AM  Page 87



88

Moving Around with
the Hand Tool

Move the Stage View

Click the Hand tool in the Toolbar. 

The pointer becomes a small hand
that moves the entire Stage
revealing other parts of the Stage
as you drag.

TIMESAVER Pressing the
space bar temporarily changes the
active tool to the Hand tool.
Continue holding as you drag.

Click and drag the Stage to move
the view. 

2

1

At certain magnifications, parts of the Stage may not be viewable. Use
the Hand tool to quickly move to different parts of the Stage without
having to change the magnification level. The Stage is the active area
of your movie, the only area that will be visible in the exported Flash
movie. The gray area around the Stage is the Work Area. The Hand tool
allows you to easily access artwork or other objects contained in this
space if you are doing detailed work at high levels of magnification. 

Did You Know?
You can turn off the visibility of the
Work Area (the gray space around the
Stage) and quickly change the View
scale to 100 percent. Toggle the Work
Area option in the View menu or use
the keyboard shortcut A+Shift+W
(Mac) or Ctrl+Shift+W (Win). This is a
great way to temporarily see what is
viewable in the exported Flash file
(.swf) when you are working with large
images that extend past the Stage
boundaries.

For Your Information

Using the Pasteboard Work Area
You can use the work area (called the Pasteboard) around the Stage
to store artwork and other objects, such as components, without
having them be visible in the published movie. The objects might not
be visible on the Stage, but they contribute to the overall file size. It
is a good idea to clean up your files before exporting the final movie.
You can clean up by removing any artwork outside the boundaries of
the Stage or by putting them on a guide layer. 

1

2
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Displaying Rulers

Show and Hide Rulers 

Click the View menu, and then
click Rulers. 

A check mark next to the option
means its visibility is enabled.

To hide rulers, click the View
menu, and then click Rulers to
remove the check mark and hide
the rulers. 

TIMESAVER Press
A+Option+Shift+R (Mac) or
Ctrl+Alt+Shift+R (Win) to turn 
the ruler on and off.

2

1

Ruler bars are located on the top and left sides of the Stage and serve
several purposes. They let you measure the width and height of Flash
elements and they let you place guides on the screen to control place-
ment of objects on the Stage. In all, Rulers serve a very important role.
When you display rulers, you can use guides to help you correctly align
objects with other objects. By using guides, you have access to precise
alignment systems. To use the guides, the ruler bars must first be visi-
ble. When you no longer need the rulers, you can hide the rulers to free
up more workspace.

Rulers
when
visible

Did You Know?
You can change the unit of measure
displayed on the Rulers. Click the
Modify menu, click Document, click
the Ruler Units popup, select a unit of
measure, and then click OK.

1

Vertical ruler

Horizontal
ruler
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Using Grids and
Guides

Show and Hide Grids 

Click the View menu, point to Grid,
and then click Show Grid.  

◆ You can also right-click the
Stage, point to Grid, and then
click Show Grid. 

A check mark next to the option
means its visibility is enabled.

To hide the grid, click the View
menu, point to Grid, and then click
Show Grid to remove the check
mark and hide the grid.

TIMESAVER Press
A+apostrophe (') (Mac) or
Ctrl+apostrophe (') (Win) to toggle
Grid visibility on and off.

2

1

Flash comes with guides, grids, and rulers to help you lay out artwork
and objects with precision. A grid is a series of crisscrossed lines that
aid in aligning objects to each other on the Stage. Guides and grids are
modifiable. You can change their visibility, position, color, and fre-
quency. These items are invisible by default, but they can be easily
turned on and adjusted. Though you see them in the Flash development
environment, they are invisible on export. Use guides to align art and
objects to each other on vertical or horizontal paths, or turn on the grid
for use in designing a layout that is proportional and balanced. 

1

See Also
See “Modifying Grid and Guide
Settings” on page 92 for information on
changing settings.

Grid when visible
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Create Guides

Click the View menu, and then
click Rulers to display rulers. 

Click on the vertical ruler on the
left side of the work area with the
Arrow pointer and drag to the
right, and then release the mouse
where you want to place the
vertical guide. 

A small directional triangle and
line appears next to the pointer as
you drag indicating that you are
dragging the guide.

Click on the horizontal ruler at the
top of the work area with the
Arrow pointer and drag down, and
then release the mouse where you
want to place the horizontal guide.

Reposition the guides by selecting
them with the pointer.

4

3

2

1

Did You Know?
You can turn guide visibility on and
off, lock guides, and enable or disable
snapping to guides. Click the View
menu, and then click Guides to access
these options or use the following key-
board shortcuts: A+; (Mac) or Ctrl+;
(Win) toggles between showing and
hiding guides Option+A+; (Mac) or
Ctrl+Alt+; (Win) locks and unlocks
guides Shift+A+; (Mac) or Ctrl+Shift+;
(Win) to turn Snapping on and off.

2

3

1

See Also
See “Displaying Rulers” on page 89 for
information on showing and hiding
rulers.
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Modifying Grid and
Guide Settings

Modify Grid

Click the View menu, point to Grid,
and then click Edit Grid.  

TIMESAVER Press
Option+A+G (Mac) or Ctrl+Alt+G
(Win) to quickly access the Grid
dialog box.

Click the Color popup, and then
click a grid line color.

Select or clear the Show Grid
check box to show or hide grid.

Select or clear the Snap To Grid
check box to enable or disable
snapping.

Enter values for horizontal and
vertical dimensions for the grid
lines.

Click the Snap Accuracy popup,
and then select a level of
sensitivity for snapping to the grid.
Select from Must Be Close,
Normal, Can Be Distant, and
Always Snap.

To make the current grid settings
the default for new Flash files,
click the Save Default button.

Click OK.8

7

6

5

4

3

2

1

The need for grids and guides varies depending upon the type of docu-
ment you are working on. They are useful for aligning text and graphics
to interface elements and are an invaluable tool for creating a well 
composed and proportioned layout. Every project is different and has
different requirements, so Flash allows the display, behavior, and char-
acteristics of guides and grids to be altered to fit your needs. They are
only visible in the Flash development environment, and are not exported
in the Flash movie.

6

2 3 4 5

8

7
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Modify Guides

Click the View menu, point to
Guides, and then click Edit Guides.

TIMESAVER Press
Option+Shift+A+G (Mac) or
Ctrl+Alt+Shift+G (Win) to quickly
access the Guides dialog box.

Click the Color popup, and then
click a guide line color. 

Select or clear the Show Guides
check box to show or hide guides.

Select or clear the Snap To Guides
check box to enable or disable
snapping.

Select or clear the Lock Guides
check box to enable or disable
editing of guides.

Click the Snap Accuracy popup,
and then select a level of
sensitivity for snapping to the
guides. Select from Must Be
Close, Normal, Can Be Distant.

To remove all guides from the
active scene, click Clear All.

To make the current guides the
default guides for new Flash files,
click Save Default.

Click OK.

TIMESAVER Press A+; (Mac)
or Ctrl+; (Win) to toggle between
showing and hiding guides; press
Option+A+; (Mac) or Ctrl+Alt+;
(Win) to lock and unlock guides; or
press Shift+A+; (Mac) or
Ctrl+Shift+; (Win) to turn Snapping
on and off.

9

8

7

6

5

4

3

2

1

6

2 3 4 5

9

7

8

C03FLCS3.qxd  4/1/2007  5:40 AM  Page 93



94

Using Snap Align

Enable Snap Align

Click the View menu, point to
Snapping, and then click 
Snap Align. 

A check mark appears next to the
menu item when Snap Align is
enabled.

Drag an object on the Stage.

Depending on the behaviors set in
the Snap Align Settings dialog box,
gray dashed lines appear when
the edges or center vertices of
objects move to within a certain
pixel distance.

2

1

Snap Align is a new feature that enables dynamic alignment of art and
objects on the Stage. Simply drag an object on the Stage and dashed
lines appear that aid you in aligning to the edge or center vertices of
other objects on the Stage. In the Edit Snapping dialog box you can
enable and disable snap options, set the distance objects to be from
the movie borders and from each other before they snap, and save the
settings as default. Additionally, you can choose to snap objects to
edges or vertical and horizontal centers. Using the Snap Align feature
enables you to lay out artwork more precisely and dynamically.

1

Edge Align Edge Align

Center Align
Horizontal

Center Align
Vertical

Snap align to other items:
Grid, Guides, Pixels, and
Objects.

Did You Know?
You can change snapping tolerances.
Click the Flash (Mac) or Edit (Win)
menu, and then click Preferences.
Click the Drawing category, use the
Connect Line popup to select an
option, and then click OK.
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Configure Snap Align and 
Save Defaults

Click the View menu, point to
Snapping, and then click Edit
Snapping. 

Select the snap check box options
you want to turn on.

Click Advanced.

Select from the following options:

◆ Movie Border. Enter a value for
the distance an object needs to
be before it will snap to the
boundaries of the movie (in
pixels).

◆ Snap Tolerance. Enter a value
for horizontal and vertical edge
tolerance (in pixels).

◆ Center Alignment. Select the
check boxes to center
alignment on horizontal or
vertical vertices or both.

To make the snap align setting the
default for future use, click Save
Default.

Click OK.6

5

4

3

2

1

4

5

6

32

For Your Information

Snapping to an Object
You can use the Snap to Object command in the View menu or use
the Snap option for the Selection tool on the Toolbar. If the Snap
option is enabled, a small black ring appears under the pointer when
you drag an object. The small ring changes to a larger ring when the
object is within snapping distance of another object.
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Changing Stroke and
Fill Colors

Change the Stroke Color

Click the Arrow tool in the Toolbar. 

Select the stroke of the shape by
double-clicking it. 

Click the Stroke color box in the
Toolbar. 

Select a new color from the
palette.

4

3

2

1

Artwork created in Flash can have strokes and fills. Strokes and fills
behave differently and are edited in different ways. A stroke is an out-
line. It describes the edges of a shape or it can be a simple line. You
can create strokes with the Line tool or the Pencil tool. A fill is a solid
shape, often contained or surrounded by a stroke. It is the surface area
of a shape and can be a color, gradient, texture, or bitmap. Fills can be
created with the Paintbrush tool and the Paint Bucket tool. The Oval,
Rectangle, and Pen tool can create shapes with either a stroke or a fill,
or both. You can edit the characteristics of strokes and fills, such as
color, in several ways. If the shape is selected on the Stage, a color
change to a stroke or fill can be made in any of the color palettes.
Because Flash uses vectors to describe shapes, you can change their
properties as much as you want without any loss in quality. It is impor-
tant to grasp the concept behind them because they are the basis for
drawing in Flash.

Did You Know?
You can change the stroke color in
three other places. Stroke color boxes
are also located in the Property
Inspector, the Color Mixer panel, and
the Swatches panel. In all cases,
select the stroke you want to change
and choose a new color from any of
the palettes.

You can change the line width and
style of a stroke or set the stroke color
to None in the Property Inspector.
Click the stroke you want to change to
select it, and then select any of the
options in the Property Inspector.
Setting the stroke color to None
removes the stroke from the shape.

1

2

3

4 Click to access the
Color Picker.

Active color
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1

2

3

4Gradients Click to access the
Color Picker.

Change the Fill Color

Click the Arrow tool in the Toolbar.

The pointer becomes an arrow.  

Click the fill of the shape to 
select it.

This is the area inside the stroke.

Click the Fill color box in the
Toolbar.

Select a new color from the
palette.

4

3

2

1

Did You Know?
You can change the fill color in three
other places. Fill color boxes are also
located in the Property Inspector, the
Color Mixer, and the Swatches panel.
Just select the fill and choose a new
color from one of the palettes by click-
ing on a new color box.

See Also
See “Editing Fills with the Paint
Bucket” on page 101 for information on
changing the fill color.
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Creating Custom
Colors

Create a Custom Color by
Entering a Value

Open or expand the Color Mixer
panel. 

Enter values between 0 and 255 in
the RGB numeric entry boxes. 

Enter an alpha value between 0
and 100. 

Click the Options button in the
panel, and then click Add Swatch.

4

3

2

1

Each Flash document has its own color palette. The color palette dis-
plays as swatches when you access a color box or panel. The default
color palette is the Web-safe palette of 216 colors. Flash allows you to
edit and create new colors for strokes and fills in several ways in the
Color Mixer panel. You can alter a color's RGB values (assigning it dif-
ferent levels of Red, Green or Blue), Hue, Saturation, Brightness, and
Alpha (transparency). You can accomplish this by using sliders, drag-
ging on a color-space, or entering a numeric value that corresponds to
a specific color. In each case you can save your color into the palette
for easy access.

Did You Know?
You can alter the RGB values with the
sliders located to the right of the
numeric entry boxes. Click the small
triangles, and then drag the sliders
that appear. Additionally, you can drag
the cursor over the Color space bar at
the bottom of the Color Mixer panel to
change the color interactively.

You can also specify a color using a
hexadecimal number in the Color
Mixer. A hexadecimal number is an
internal computer numbering scheme
that is used to identify colors in a color
palette.

1

4

Options button

3

2

Color space bar
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Create a Custom Color with
the Color Picker

Click a Stroke or Fill color box in
the Toolbar or the Property
Inspector.  

Click the Color Wheel button to
the far right of the palette.

Click a color from one of the
available pickers (Mac) or from the
Color Window (Win).

Click OK.4

3

2

1

1

2

3

For Your Information

Working with Color Palettes
Each Flash file stores its own color palette, Web safe 216 by default.
If you change color in the default color palette, you can save the
new palette as the default or change back to the Web safe 216
default. To view the color palette, click the Window menu, and then
click Color Swatches. To load or save the default palette, click the
Options button in the Color Swatches panel, and then click Load
Default Colors or Save As Default. To reload the Web-safe color
palette, click the Options button, and then click Web 216.

Did You Know?
You can import and export solid and
gradient color palettes between Flash
files and other applications. You can
share color palettes between applica-
tions, such as Adobe Fireworks and
Adobe Photoshop. Click the Window
menu, and then click Color Swatches.
Click the Options button on the panel,
and then click Add Colors or Replace
Colors to import colors from a color
palette, or click Save Colors to export
as a color palette.

4
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Editing Strokes with
the Ink Bottle

Use the Ink Bottle

Select a stroke on the Stage, and
then change Stroke attributes in
the Property Inspector. 

Click the Ink Bottle tool in the
Toolbar. 

The pointer becomes a small ink
bottle.

TIMESAVER Press S to select
the Ink Bottle tool.

Click on the stroke of the shape to
update it with the new attributes.

The stroke updates to the new
color.

3

2

1

There are a number of ways to change the stroke of an object. You can
select the stroke and change its characteristics in the Property
Inspector, the Swatch palettes, and the Color Mixer. If you need to
apply the stroke properties of one object to that of another, use the Ink
Bottle tool. The Ink Bottle tool holds the properties you've set for
strokes in any of the palettes. You can click any object on the Stage to
change the properties of its stroke (color, line weight and style) or add
a stroke to an object that doesn't have one.

Did You Know?
You can click anywhere on the shape
with the Ink Bottle to change the
stroke. If the object on the Stage is
selected (stroke and fill), click down
with the Ink Bottle tool to update its
stroke.

1
Stroke

Color
Stroke
Weight

Stroke
Style

Built-in Stroke styles 

3

Shape with
updated stroke

Customize
styles

2
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Editing Fills with the
Paint Bucket

Use the Paint Bucket

Change the Fill color box in either
the Property Inspector, the Colors
area of the Toolbar, or the Color
Mixer.

Click the Paint Bucket tool in the
Toolbar. 

The pointer becomes a small paint
bucket.

TIMESAVER Press K to select
the Paint Bucket tool.

Click in the fill of a shape on the
Stage.

The fill updates to the new color.

3

2

1

You can change the fill of an object with the Paint Bucket tool. The
Paint Bucket stores the fill color you've set in the Toolbar or in the
Property Inspector. You can change the fill color of any existing shape
on the Stage by touching down on the shape with this tool. You can
also add a fill to any shape that has a closed stroke. After you select
the Paint Bucket tool, you can select Paint Bucket sensitivity options
located at the bottom of the Toolbar.

2

3 Shape with updated fill

Paint Bucket sensitivity

Paint Bucket Options

1

Did You Know?
You can set the sensitivity of the Paint
Bucket tool in the Options areas of the
Toolbox. These settings allow the Paint
Bucket tool to close gaps in a shape
(such as a break in the stroke line) and
adjust how large or small a gap needs
to be before Flash will close it.

C03FLCS3.qxd  4/1/2007  5:42 AM  Page 101



102

Ink Bottle appears
when you click on a
stroke.

Editing Strokes and
Fills with the
Eyedropper

Use the Eyedropper Tool to Edit
Strokes and Fills

Click the Eyedropper tool in the
Toolbar. 

The pointer becomes an
eyedropper.

TIMESAVER Press I to select
the Eyedropper tool.

Position the eyedropper over the
stroke or fill of a shape on the
Stage. 

◆ Strokes. When you are
positioned over a stroke, a tiny
pencil appears next to the tool.
When you click on the stroke
the Eyedropper becomes an Ink
Bottle.

◆ Fills. When you are positioned
over a fill, a tiny paint brush
appears next to the tool. When
you click on the fill the
Eyedropper becomes a Paint
Bucket.

Click on another shape's stroke or
fill to transfer the selected
attributes.

The stroke or fill updates to the
new color.

3

2

1

The Eyedropper tool allows you to select the attributes of a shape such
as fill and stroke color, and line weight and style, and then transfer
them to other shapes. This tool detects whether you are selecting a
stroke or a fill, and then changes into the Ink Bottle (when selecting
strokes) or the Paint Bucket (when selecting fills). Instead of taking
several steps to copy attributes from one shape to another, the
Eyedropper provides a quick means for storing and transferring attrib-
utes between editable shapes.

Paint Bucket appears
when you click on a fill.

1

Tiny Pencil appears
indicating
eyedropper is
positioned over a
stroke.

Tiny Paint brush appears
indicating eyedropper is
positioned over a fill.
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Creating Gradients

Create a Multi-Color Gradient

With the Arrow Selection tool,
select the fill or stroke of a shape
on the Stage.

In the Color Mixer panel, click the
Fill Style Type popup, and then
click Linear or Radial.

Click the Overflow popup, and
then select the gradient overflow
style you want to control colors
past the limits of the gradient
when publishing for Flash Player 
8 (New!).

Position the pointer on the
Gradient bar to display a plus (+)
sign next to the pointer.

Click in the Gradient bar to create
a color proxy indicated by a little
box with a triangle on top.

TIMESAVER To remove a
proxy color indicator, drag it down.

Click one of the color proxy
indicators to select it.

Click a new color from the Color
Picker below.

Drag the color proxy indicator
along the Gradient bar to adjust
the color placement.

Repeat steps 4-8 to add up to 15
more gradient colors.

9

8

7

6

5

4

3

2

1

Flash can create a number of paint effects in addition to solid colors.
Gradients are made up of two or more colors that gradually fade into
each other. They can be used to give depth to an object or create real-
istic shadows. Two gradient modes are available: linear and radial.
Linear gradients are made up of parallel bands of color. Radial gradi-
ents radiate from a center focal point. Both can be edited for color,
alpha, and position within a fill or stroke. You can add up to 16 colors to
a gradient, precisely control the location of the gradient focal point,
and apply other parameters. A gradient behaves like any other fill or
stroke. It can be saved to the palette as a swatch using the Color Mixer
panel Options button, and added to other shapes with the Paint Bucket
tool.

Example: 
3-Color
Linear
Gradient

1

5

2

6

4

3

7
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Using the Fill Lock

Lock Gradients

Create two simple shapes using
the Rectangle or Oval tool. 

Select the first shape on the Stage
with the Arrow Selection tool.  

Click the Paint Bucket tool in the
Toolbar.

TIMESAVER Press K to select
the Paint Bucket Tool.

Click the Lock Fill button in the
Options area of the Toolbar. 

Select a Gradient from the Colors
area of the Toolbar or use the
Color Mixer or Property Inspector.

Click the Eyedropper tool in the
Toolbar, and then click on the
gradient fill in the first shape.

Click down on the second shape to
add the gradient fill.

7

6

5

4

3

2

1

As you increase the complexity and number of shapes in your movie, it
can become tricky to edit each object separately. When using gradient
fills on several objects you can choose to span a gradient across sev-
eral of these objects or give each object its own discreet gradient. The
Lock Fill feature allows you to control how a fill is applied, essentially
locking its position so that depending on where the shapes are posi-
tioned relative to the gradient, the one gradient spans all of the shapes.
If you apply the same gradient to multiple shapes with the Fill Lock off,
the gradient is applied to each shape independently. 

Did You Know?
You can quickly add a gradient that
spans all of your shapes. Select all of
the objects you want to fill, and then
choose a gradient. Click the Paint
Bucket tool and make sure the Fill Lock
is not selected. With your shapes still
selected, touch down on them with the
Paint Bucket. 

6

4

3

5

2 7

1

Shape 1 and 2
with Fill Lock

Shape 1 and 2
without Fill Lock
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Using Paint Brush
Modes

Use Paint Brush Modes

Click the Paint Brush tool in the
Toolbar. 

Click the Brush Mode popup in the
Options area in the Toolbar, and
then select from the following:

◆ Paint Normal. The brush paints
over everything including
strokes and other fills.

◆ Paint Fills. Painting only affects
existing fills and empty areas of
the Stage. Strokes are ignored.

◆ Paint Behind. The Paint Brush
only affects empty areas of the
Stage keeping existing lines
and fills intact.

◆ Paint Selection. Painting only
affects the selected areas you
define with any of the selection
tools.

◆ Paint Inside. The Paint Brush
only affects the fill of the shape
you started in, ignoring other
shapes and empty areas on the
Stage.

2

1

In addition to size, shape, and color settings for the Paint Brush tool,
you can control how the brush behaves when painting on existing
shapes and objects on the Stage. Paint Brush modes can restrict the
area affected by the tool to fills or selections, empty areas of the Stage
or specific shapes. When the Paint Brush tool is selected, a popup
menu appears in the Toolbar. Select from the following modes: Paint
Normal, Paint Fills, Paint Behind, Paint Selection, and Paint Inside. Each
performs a specific operation providing you with varying levels of con-
trol as you paint. Flash previews your paint path as you paint, but it only
affects the areas you've specified in the Paint modes. When you
release the mouse, these previews disappear. 

Paint Normal

Paint Fills Paint Behind

Paint InsidePaint Selection

Brush mode options

1

2
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Drawing with the 
Pen Tool

Use the Pen Tool to Create an
Open Path

Click the Pen tool arrow in the
Toolbar, and then click Pen Tool. 

TIMESAVER Press P to quickly
select the Pen tool.

Click on the Stage.

An anchor point is created.

Move your pointer to another
position, and then click again.

Flash connects the two anchor
points.

Double-click to end the path.

TIMESAVER Ctrl+click (Win) or
Command+click a blank area to
leave the path open.

4

3

2

1

The Pen tool is the basis for vector drawing. The Pen tool now behaves
similarly to the Illustrator Pen tool to provide consistency across Adobe
software (New!). Flash provides a number of ways to draw and edit
objects that are unique to Flash but the Pen tool utilizes procedures
that will be familiar to those who have used other vector drawing pro-
grams. The Pen tool utilizes anchor points and Bézier handles to create
lines and shapes and behaves in a way that is familiar to those who
have used other programs such as Adobe Illustrator and Adobe
FreeHand. You can use the Pen tool arrow to select a different pen to
add, delete, or convert anchor points. You can edit the anchor points
and vectors to create the drawings you want.

Did You Know?
You can end an open path using a key-
board shortcut. Press A+click (Mac)
or Ctrl+click (Win).

See Also
See “Modifying Shapes with the Sub-
Selection Tool” on page 112 for infor-
mation on using tools.

2 3

Open path drawn

1

Pen tools
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Use the Pen Tool to Create a
Closed Path

Click the Pen tool arrow in the
Toolbar, and then click Pen Tool. 

TIMESAVER Press P to quickly
select the Pen tool.

Click on the Stage.

An anchor point is created.

Move your pointer to another
position, and then click again.

Flash connects the two anchor
points.

Move the pointer to a third
position, and then click again.

Flash connects the second and
third anchor points.

Move the pointer back to the first
anchor point. 

A small circle appears next to the
pen pointer indicating you can
close the path of the shape.

Click to close the shape.6

5

4

3

2

1

Did You Know?
You can delete an anchor point with
the Pen tool. Click the Pen tool arrow,
click Delete Anchor Point Tool, and
then click the point you want to delete. 

You can add an anchor point with the
Pen tool. Click the Pen tool arrow,
click Add Anchor Point Tool, and then
click where you want to add a point. 

You can create horizontal, vertical,
and 45 degree lines while you draw.
Hold the Shift key while you draw to
constrain a line to horizontal, vertical,
and 45 degree angles.

2 3

1

4

5

Closed path drawn

Understanding Pen Pointers

Pointer Description

Initial Anchor Point First pointer to create the beginning of
a new path.

Sequential Anchor Creates an anchor point with a line
Point connecting the previous anchor point.

Add Anchor Point Adds an anchor point to existing path.

Delete Anchor Point Deletes an anchor point within a path

Continue Path Extends a new path from an existing
anchor point.

Close Path Closes the path of a drawing on the 
starting anchor point.

Join Paths Closes the path except not over the 
starting anchor point.

Retract Bézier Handle Displays Bézier handles when you point
to an anchor. Click to retract then 
handles and revert to straight segments.

Convert Anchor Point Converts a corner point without 
direction lines to a corner point with 
independent direction lines. Use Shift+C
modifier keys to toggle the pen.
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Drawing Curves with
the Pen Tool

Create Curved Line Segments

Click the Pen tool arrow in the
Toolbar, and then click Pen Tool. 

Click on the Stage without
releasing the mouse, drag up, and
then release the mouse.

Position the pointer to the right of
the original point, drag in the
opposite direction of the curve,
and then release the mouse when
the curve is where you want it.

Continue adding points as needed.
To end the path, double-click or
return to the last anchor point
drawn and click on it.

4

3

2

1

The Pen tool can be used to draw precise and complex curves by sim-
ply clicking and dragging it on the Stage. These curves can be modified
with precision by adjusting the Bézier handles that extend from the
anchor points, or you can move the anchor points themselves. In this
way, you can create any number of shape variations. For best results,
make the grid visible so aligning anchor points isn't such a mystery.

Did You Know?
You can select to Show Precise
Cursors instead of the Tool icons in
the General tab of the Preferences
dialog box. When this option is
selected, drawing tools, such as the
Pen tool, appear as crosshairs for bet-
ter precision and alignment to grids
and guides.

You can convert a curve point to a cor-
ner point. Click the Pen tool arrow,
click Convert Anchor Point Tool, and
then click the curve point you want to
covert to a corner point. 

1

2

3

Curved line segment drawn
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Create S-Curves

Click the Pen tool arrow in the
Toolbar, and then click Pen Tool. 

Click on the Stage without
releasing the mouse, drag down,
and then release the mouse.

Position the pointer to the right of
the original point, drag in the same
direction as the first drag, and
then release the mouse when the
curve is where you want it. 

Continue adding points as needed.
To end the path, double-click or
return to the last anchor point
drawn and click on it.

4

3

2

1

1

2

3

S-Curve drawn
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Modifying Shapes
with the Arrow Tool

Use the Arrow Tool to Modify 
a Shape

Create a simple oval shape using
the Oval tool.

Click the Arrow tool in the Toolbar. 

The pointer becomes an arrow.

Make sure the shape you want to
modify is not selected.

Position the pointer on the edge of
the shape, and then drag to modify
the shape.

You can pull the curve to any
position.

4

3

2

1

In Flash, unlike other vector drawing programs, you can edit shapes
and lines in a unique, freeform way by simply dragging with the Arrow
Selection tool. You can quickly adjust the curve or corner of a shape or
line without having to select anchor points or use any other tools. This
way of editing shapes is also useful for creating shape tweens where
amorphous, organic movement is desired. This is what sets Flash apart
from other animation tools and gives it its distinctive style. Additionally,
you can convert curved line segments into corner points with this sim-
ple drag technique.

2

1

4

Modified shape
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Convert Line Segments with the
Arrow Tool

Create a simple oval shape using
the Oval tool.

Click the Arrow tool in the Toolbar. 

The pointer becomes an arrow.

Make sure the shape you want to
modify is not selected.

Position the pointer on the edge of
the shape.

Press Option+drag (Mac) or
Alt+drag (Win) to create a corner
point.

5

4

3

2

1

2

1

4

Modified shape

More corners added
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Modifying Shapes 
with the Sub-
Selection Tool

Use the Sub-Selection Tool to
Modify a Shape

Create a simple oval shape using
the Oval tool.

Click the Sub-Selection tool in the
Toolbar. 

The pointer becomes an empty (or 
white) arrow.

Click on the edge of the shape to
reveal the anchor points, and then
click on an anchor point to 
select it or drag a selection
rectangle to select multiple anchor
points.

The anchor points are the little
white squares around the edge of
the shape. When selected, Bézier
handles appear on either side of
the anchor point.

Grab one of the handles or the
anchor points themselves and
drag it, and then release the
mouse.

4

3

2

1

Vector shapes are made up of anchor points connected by line seg-
ments. There are two types of anchor points: corner points and curve
points. Corner points connect two line segments in a sharp angle such
as the corner of a square. Curve points define a curve or positions
along a straight line and can be modified with Bézier handles. These
handles extend out from the curve point and allow for very precise
modification of the shape of the curve. The Sub-Selection tool works
hand-in-hand with the Pen tool to create and modify shapes and lines
in this way.

Did You Know?
You can also use the arrow keys on
the keyboard to move selected anchor
points. Select one or more anchor
points with the Sub-Selection tool, and
then press the arrow keys to move the
anchor point and its connected lines in
the direction of the key you press. 

2

3

1

4
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Convert Corner Points to 
Curve Points 

Create a simple rectangle shape
using the Rectangle tool.

Click the Sub-Selection tool in the
Toolbar. 

The pointer becomes an empty (or
white) arrow.

Click on the edge of the shape to
select it and then click on one of
the corner points to select it.

Press Option+drag (Mac) or
Alt+drag (Win) the point to convert
it to a curve point and create
Bézier handles.

Convert Curve Points to 
Corner Points 

Create a simple oval shape using
the Oval tool.

Click the Pen tool in the Toolbar. 

The pointer becomes a small pen.

Click on the edge of the shape to
reveal the anchor points.

Position the pointer over one of
the curve points. 

A small corner icon appears.

Click on the point to convert it to a
corner point.  
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1
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4

5 All anchor points
converted to
corner points.

?

2
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Using the Free
Transform Tool

Change the Scale of an Object

Select the object by clicking on it
or by dragging a selection
marquee around it with the Arrow
tool. 

Click the Free Transform tool in the
Toolbar. 

TIMESAVER Press Q to select
the Free Transform tool.

Click the Scale Modifier button in
the Options area of the Toolbar. 

Drag any of the small handles on
the bounding box to change the
size of the shape. The corner
handles resize proportionally while
the handles along the sides resize
either horizontally or vertically.

To change the transformation
point, drag the circle handle. 

5

4
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1

There are a number of ways to change the scale or size of graphics in
Flash. The Free Transform tool position on Toolbar allows you to inter-
actively scale and rotate any selected object or shape on the Stage.
Nearly every object in Flash can be transformed with these two func-
tions of the Free Transform tool including groups, symbols, text,
bitmaps, and editable shapes. The Free Transform tool allows you to
select an object on the Stage and then interactively change its size or
rotate it freely. Both options are available at once depending on where
you place your mouse on the bounding box that appears.

3

2

4

Did You Know?
You can restore a transformed object.
Select the transformed object, click
the Modify menu, point to Transform,
and then click Remove Transform. 

You can reset a transformed object. If
you want to redo a transformation,
select the object, and then click the
Reset button in the Transform panel
(available on the Window menu). 

For Your Information

Working with the Transformation Point

When you transform an object, a transformation point appears at the
center of the object. The point is initially placed in the center of the
object, but you can move it at any time. To move the transformation
point during a transformation, drag the point. To set it back to the
center, double-click the point. To switch the point of origin for a scale
or skew, Alt+drag (Win) or Option+drag (Mac) the point. To monitor
the location of the transformation point (X and Y positions), click the
center square in the grid in the Info panel (available on the Windows
menu).

5

C03FLCS3.qxd  4/1/2007  5:47 AM  Page 114



Chapter 3 Creating Graphics 115

Rotate and Skew an Object

Select the object by clicking on it
or by dragging a selection
marquee around it.

Click the Free Transform tool in the
Toolbar.  

TIMESAVER Press Q to select
the Free Transform tool.

Click the Rotate/Skew Modifier
button in the Options area of the
Toolbar.

Drag any of the corner handles on
the bounding box to rotate the
shape. Drag the handles along the
side to skew the object.

To change the transformation
point, drag the circle handle. 

5
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Did You Know?
You can hold down the Shift key to
constrain the rotation scale propor-
tionally. When rotating, it constrains
the rotation to 45-degree turns. 

For Your Information

Working with Scale and Rotate
In the Default mode, both Scale and Rotate are enabled. Move the
pointer to any of the four corner handles in the bounding box to
enable the Rotate function. Scale and Rotate work relative to a cen-
ter transformation point on the shape, which becomes visible when
the shape is selected with the Free Transform tool. Move this point if
you want to scale or rotate a shape from a different part of the
shape. This is especially important when tweening and animating.
You can change the scale and rotate objects by entering values in
the Transform panel or in the Property Inspector. You can also
access all of the Transform modes and some additional effects, such
as Flip Horizontal and Vertical from the Transform submenu in the
Modify menu.

4

3

2

5

4 Skew

Rotate
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Using Transform
Options for Shapes

Distort a Shape

Select the object.

Click the Free Transform tool in the
Toolbar.  

TIMESAVER Press Q to select
the Free Transform tool.

Click the Distort Modifier button in
the Options area of the Toolbar.

Drag any of the corner handles on
the bounding box to distort the
shape.

Drag any of the side handles on
the bounding box to skew or
stretch the shape.

Change the Envelope of a Shape

Select the object.

Click the Free Transform tool in the
Toolbar.  

TIMESAVER Press Q to select
the Free Transform tool.

Click the Envelope Modifier button
in the Options area of the Toolbar.

Drag any of the handles on the
bounding box to pull the shape in
any direction or use the Bézier
handles to fine tune the curves.
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In addition to the scale and rotation changes that can be applied to
groups, symbols, bitmaps, and text as well as editable shapes, there
are two additional transforms available only to editable shapes. Distort
and Envelope are two modes available in the Free Transform tool
options that enable you to transform the vectors of editable shapes to
varying degrees. Distort transformations work on adjoining edges,
tapering them down to vanishing points, similar to perspective.
Envelope transformations allow you to warp the edges of a shape by
splitting it up into smaller portions each controlled by their own vectors
and anchor points. 

3

4
2

5

4

3

2
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Transforming 
Gradient Fills

Adjust a Gradient Fill

Click the Gradient Transform tool
in the Toolbar. 

Click the gradient fill to select it.

A bounding box appears around it. 

Position the pointer over an editing
handle on the bounding box to
identify its function.

◆ Center point. Four-way arrow.

◆ Focal point. Inverted triangle.

◆ Size. Circle with an arrow.

◆ Rotation. Four arrows in the
shape of a circle.

◆ Width. Double-ended arrow.

Click and drag an editing handle to
adjust the gradient fill.

4

3

2

1

After you create a gradient fill, you can transform it by adjusting the
size, rotation, width, or center of the fill with the Gradient Transform
tool (formally called the Fill Transform tool). For a radial gradient, you
can now adjust the focal point (center) of a gradient fill applied to an
object. You can also use the Gradient Transform tool to modify a bitmap
fill.

See Also
See “Modifying a Bitmap Fill” on page
196 for information on using the
Gradient Transform tool with bitmaps.

1 2 4

Use Color Mixer to change
color gradient settings

Radial gradient
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Cutting and Pasting
Graphics Between
Layers

Paste Objects Between Layers

Create or open a document with
several layers. 

Select one or more objects on the
Stage.  

Flash selects the object’s layer in
the Timeline.

Click the Edit menu, and then click
Cut or Copy.

Select a destination layer in the
Timeline.

Click the Edit menu, and then click
Paste In Center.

Flash pastes the objects on the
Stage in the middle of the active
layer.
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1

Unless you lock or hide layers, or lock objects, the graphics on all lay-
ers are available for editing. You can select objects on one or more lay-
ers, cut or copy them, and then paste them all into a single layer. Flash
can have only one layer active at a time. When you create and paste
graphics, Flash places them on the active layer of a document. You can
paste objects in two different ways: Paste In Center and Paste In Place.
Paste In Center puts objects in the center of the open Flash window,
which might not be the Stage. If you want to paste to the center of the
Stage, you need to center the Stage in the open window. Paste In
Place puts objects at the same location it had been when you cut or
copied it.

2

1

4

Shape pasted on
layer 2 in the center.

Did You Know?
You can use the area around the Stage
to store graphics and other objects.
Flash allows you to use the area
around the Stage, called the
Pasteboard, to store items for use later
without having them appear on the
Stage when you play the movie (SWF)
file.
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Use the Paste In Place
Command Between Layers

Create or open a document with
several layers. 

Select one or more objects on the
Stage.  

Flash selects the object’s layer in
the Timeline.

Click the Edit menu, and then click
Cut or Copy.

Select a destination layer in the
Timeline.

Click the Edit menu, and then click
Paste In Place.

Flash pastes the objects into their
original locations on the Stage in
the middle of the active layer.
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4

Shape pasted on
layer 2 in place.

2
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Working with
Graphics on Different
Layers

Edit Object on Inactive Layers

Create or open a document with
several layers. 

Click the Selection tool in the
Toolbar.  

Select an object on the Stage.  

Flash selects the object’s layer in
the Timeline.

Click a blank area of the Stage.

Flash deselects the object but
keeps the active layer.

Make changes to another object in
another layer (inactive layer)
without actually selecting the
object. You can do any of the
following:

◆ Drag an object’s outline to
reshape it.

◆ Select a tool on the Toolbar,
such as the Paint Bucket tool,
and use it to modify the object.

Flash modifies the object in the
inactive layer. The active layer
didn’t change. Flash changes
active layers only if you select an
object.

5

4
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1

When you select an object on the Stage, Flash selects the object’s
layer in the Timeline. The reverse is also true. When you select a layer
in the Timeline, Flash selects all the objects for that layer on the Stage.
As you work with objects on different layers, it helps to know how
selections work. Unless you lock or hide layers, or lock objects, the
objects on all layers, either active or inactive, are available for editing.
You can activate a layer and edit objects on inactive layers.

2

1 Layer 1 active

3

4

Layer 1 still active

5
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Distributing Graphics
to Layers

Place Selected Objects on
Separate Layers

Create or open a document with
several objects on a single layer. 

Select all the objects on a single
layer you want to distribute to
separate layers.  

TIMESAVER Click the Edit
menu, and then click Select All or
press A+A (Mac) or Ctrl+A (Win).

Click the Modify menu, point to
Timeline, and then click Distribute
To Layers.  

TIMESAVER Press A+Shift+D
(Mac) or Ctrl+Shift+D (Win) to
distribute to layers.

Flash creates a layer for each
object. New layers appear at the
bottom of the Timeline in the order
in which you originally placed
them on the Stage. Each object is
placed in the same location on the
Stage (like the Paste In Place
command).

3

2

1

If you have several objects on a single layer, and need to move them
onto separate layers, you can use Cut and Paste in place for each
object or you can save time by using the Distribute to Layers command.
The Distribute to Layers commands puts each object (shapes, groups,
and symbols) in a selection on a separate layer; any unselected objects
remain on their original layer. This command comes in handy when you
want to create a motion tweening animation, which requires objects to
be on individual layers. 

See Also
See Chapter 8, “Animating with Motion
Tweening” on page 221 for information
on using motion tweening.

1

2

Shape on layer 5

Text on layer 3

Shape on layer 4

Text on layer 2
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Working With Object
Drawing

Enable and Use Object Drawing

Select a drawing tool in the
Toolbar that supports Object
Drawing (Pencil, Line, Pen, Brush,
Oval, Rectangle, and Polygon). 

Select the Object Drawing button
in the Toolbar.

TIMESAVER Press the J key to
toggle between Merge and Object
Drawing.

With the Pointer tool, click to
select an object, and then drag the
bounding box to move it.

To switch back Merge Drawing,
click the Object Drawing button
again. 
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Previously in Flash, all shapes in the same layer on the Stage could
change other overlapping shapes, known as Merge Drawing. In Flash,
you can create shapes directly on the Stage that do not affect other
overlapping shapes, known as Object Drawing. By default, Flash uses
Merge Drawing. To draw shapes using Object Drawing, you use the
Object Drawing button in the Toolbar. When you select a shape created
using Object Drawing, Flash selects the shape with a rectangular
bounding box, which you can use with the Pointer tool to move the
shape on the Stage. You can use General preferences to set selection
options for contact-sensitivity when selecting shapes created using
Object Drawing.

See Also
See “Setting General Preferences” on
page 60 for information on options for
contact-sensitivity when selecting
shapes created using Object Drawing.

Did You Know?
You can convert a Merge Drawing
shape to an Object Drawing shape.
Select the shape on the Stage, click
the Modify menu, point to Combine
Object, and then click Union. 

1

2

Bounding box

Objects created
with Object Drawing

3

C03FLCS3.qxd  4/1/2007  5:50 AM  Page 122


